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 AVR® DA 培训手册

 采用AVR128DA48 Curiosity Nano的差分ADC

准备工作

本部分旨在列出完成本培训需满足的所有要求。

硬件准备工作

• AVR128DA48 Curiosity Nano（DM164151）
• 适用于 Click boards™的 Curiosity Nano 基板（AC164162）
• POT Click 板（MIKROE-3402）
• POT 2 Click 板（MIKROE-3325）

注：两块 POT Click 板可替换为任何其他两个电位器，相关原理图见下文。

软件准备工作
下面给出了本培训的软件准备工作。

• MPLAB® X IDE v5.40 或更高版本

• MPLAB XC8 编译器 v2.20 或更高版本

• AVR-Dx_DFP（器件系列包）v1.1.40
• MPLAB 数据可视化器（MPLAB Data Visualizer，MDV）v1.1
• MPLAB 代码配置器（MPLAB Code Configurator，MCC）v3.95
• MCC 8 位 AVR® MCU 库 v2.3.0

文档材料

• AVR128DA28/32/48/64数据手册
• TB3245 -《使用 12 位 ADC 进行转换、累加和触发事件》

• 其他器件相关文档可访问以下位置获取：AVR128DA48 器件概述

https://www.microchip.com/Developmenttools/ProductDetails/DM164151
https://www.microchip.com/Developmenttools/ProductDetails/AC164162
https://www.mikroe.com/pot-click
https://www.mikroe.com/pot-2-click
http://ww1.microchip.com/downloads/en/DeviceDoc/40002183A.pdf
http://ww1.microchip.com/downloads/en/Appnotes/12BitADC-Conv-Accumulation-Triggering-Events-DS90003245B.pdf
https://www.microchip.com/wwwproducts/en/AVR128DA48
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简介

鉴于许多外部激励都是模拟类型的激励，因此嵌入式应用经常依赖于模拟输入（由模拟传感器提供）。大多数

Microchip 单片机（MCU）都集成了模数转换器（Analog-to-Digital Converter，ADC）来获取模拟数据，并且能够对

此类数据进行处理。

本文档介绍了如何借助 AVR128DA48 Curiosity Nano 评估工具包来使用 ADC 的差分转换功能开发应用程序。其中提

供了外设的概述，并逐步说明了如何将 ADC 配置为差分模式。

完成本培训后，用户将能够：

• 通过配置所有外设初始化系统

• 启动 ADC 转换

• 连续读取 ADC 结果并通过通用同步/异步收发器（Universal Synchronous/Asynchronous Receiver/Transmitter，
USART）进行发送

• 分步运行应用程序以理解具体配置

• 使用硬件设置来测试开发的应用程序

• 使用图形界面工具查看数据

首先提供 ADC 模块的概述，然后介绍要开发的应用程序，最后提供实现该应用程序所需的步骤：熟悉软件工具、初始

化系统和外设模块、实现其他需要的功能、调试应用程序以及使用 MPLAB 数据可视化器查看收到的数据。
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1. 概述
本章提供 ADC 模块的概述以及本培训的内容。

1.1 模数转换器模块概述

本文档所述的应用程序使用 AVR128DA48 器件进行开发。该器件配有 12 位分辨率的 ADC 模块，支持单端和差分两种

模式。

ADC 输入信号通过一个采样保持电路馈送，可确保 ADC 的输入电压在采样期间保持在恒定水平。ADC 参考电压在

VREF 外设中配置。

下面给出了 ADC 模块的框图。

图 1-1. ADC 框图
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模块必须使用相应的模块寄存器进行配置。数据手册的寄存器汇总和寄存器说明两章列出了模块的所有寄存器，并介

绍了模块寄存器的所有位和位域的功能。

在本应用程序示例中，ADC 将配置为差分模式。差分 ADC 用于测量两个输入之间的电压差。这在某些应用中可能是

至关重要的，因为一些测量概念需要使用两个输出信号（而非一个）来量化所关注的物理特性。实现这种概念的传感

器通常以两个信号之间的电压差提供其输出值，也称为差分信号。其他传感器可能会为了增加稳健性而提供差分输

出，即使测量本身生成的是单端信号也如此。

将差分模拟传感器连接到 MCU 时，差分对中的一个信号被定义为正输入，另一个信号被定义为负输入。差分信号的值

是以负输入为参考的正输入电压。每个信号的正负标识决定了差分信号的极性，当正输入大于负输入时，定义为正；

当负输入大于正输入时，定义为负。转换结果的计算公式如下：ADCresult = VAINP− VAINNVREF × 2048 ∈ − 2048和 2047
其中，VAINP 和 VAINN 是 ADC 的正负输入，而 VREF 是选定的 ADC 参考电压。差分转换的数据格式是带符号扩展的二

进制补码。

1.2 应用程序概述

图 1-2 给出了开发和测试本应用程序所需的硬件设置。在 Curiosity Nano 开发板上，使用两个电位器为 AVR128DA48
器件提供模拟输入信号。ADC 将对这两个输入信号之间的电压差进行转换。转换结果将通过 USART 进行发送，并使

用 MPLAB 数据可视化器插件进行绘制。
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图 1-2. 硬件设置
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本培训设计的软件应用程序将实现以下软件流程图。初始化系统后，将启动自由运行的 ADC 转换。之后，将利用无限

循环连续读取结果状态并通过 USART 进行发送，最终使用图形界面进行显示。

图 1-3. 软件图
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2. 模数转换器培训

2.1 图标标识符
本小节提供了用于指导用户完成培训的图标及其含义，具体如下所示。

信息：
该图标将用于强调有用的信息。

任务：
该图标将用于指出有一项用户必须完成的任务：配置模块设置或实现代码。

结果：
该图标将用于标记任务的结果。

2.2 硬件设置
用于开发所提供的培训材料的硬件包含在用于 AVR128DA48 器件的 Curiosity Nano 开发板中，如图 2-1 所示。

图 2-1. Curiosity Nano 板

为了方便集成其他对该应用程序有用的组件（如 POT Click 板和 POT 2 Click 板），可以使用 Curiosity Nano 适配器板

（如图 2-2 所示）。



 AVR® DA 培训手册
模数转换器培训

© 2023 Microchip Technology Inc.
及其子公司

  培训手册 40002244A_CN-第 7 页

图 2-2. Curiosity Nano 适配器板

注：演示原型使用两个简单的电位器来构建。为了方便集成这两个电位器，可以使用 MIKROE POT Click 板和 POT 2
Click 板，以及 Curiosity Nano 适配器板。

电位器与 Curiosity Nano 适配器板之间的连接如图 2-3 所示。

图 2-3. 电位器连接原理图
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2.3 熟悉软件环境
本节帮助用户熟悉如何创建新项目，并介绍必要的插件及其安装步骤。
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2.3.1 使用 MPLAB® X IDE 创建新项目

1. 要使用 MPLAB X IDE 创建新项目，请转到 File → New Project...（文件 → 新建项目...），随后将显示 New
Project（新建项目）向导。该步骤如图 2-4 所示。

图 2-4. 创建新项目
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2. 在 Choose Project（选择项目）步骤中，从 Categories（类别）中选择 Microchip Embedded（Microchip 已

安装工具）并从 Projects（项目）中选择 Standalone Project（独立项目），然后单击 Next（下一步）。随后

将创建一个新的独立应用程序项目。该步骤如图 2-5 所示。

图 2-5. 选择项目



 AVR® DA 培训手册
模数转换器培训

© 2023 Microchip Technology Inc.
及其子公司

  培训手册 40002244A_CN-第 10 页

3. 下一步是选择要进行编程的器件。本文档所述的应用程序是使用 8 位 AVR MCU 系列的 AVR128DA48 器件实

现。选择该器件后，单击 Next。

图 2-6. Select Device
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4. 之后，在 Select Tool（选择工具）步骤中，从 Microchip Kits → AVR128DA48 Curiosity Nano (PKOB nano)
（Microchip 工具包 → AVR128DA48 Curiosity Nano (PKOB nano)）中选择所需的工具（SN:MCHP...）。这是

一个可选步骤。如果该工具不可用或尚未连接，用户可从 Hardware Tools（硬件工具）中选择 Simulator（软

件模拟器）工具，或者等到需要时再做选择。

图 2-7. 选择工具

信息：用户还可以双击工具名称，为其设置易记的名称（Friendly Name，FN）。
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5. 选择本项目所需版本的 XC8 编译器，如图 2-8 所示。

图 2-8. 选择编译器
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6. 最后一步是 Select Project Name and Folder（选择项目名称和文件夹）。在本例中，项目名称将是

avr128da48-cnano-adc-diff。在该步骤中，用户还可以配置项目位置、项目文件夹和编码。

图 2-9. 选择项目名称和文件夹

完成所有必要的步骤后，项目窗口中将出现一个新的空项目。所有必要的文件都将使用 MCC 插件引入项目中。

2.3.2 MPLAB®代码配置器（MCC）

本项目将使用 MCC 进行开发。MCC 是一款图形编程环境，可生成简单易懂的 C 语言代码，之后插入您的项目中。它

采用直观界面；可针对目标应用程序来使能和配置众多外设及功能。

安装该插件时，可遵循安装 MPLAB®代码配置器（MCC）网页上提供的步骤。

在生成所有必要的源文件和头文件后，用户必须补全源代码以获得所需的功能。实现代码后，必须对应用程序的功能

进行测试，具体将使用 MDV 插件来完成。

2.3.3 MPLAB®数据可视化器（MDV）
MDV 是一款图形化的运行时调试工具，既可以作为 MPLAB 插件使用，也可以作为独立的调试工具使用。该工具以图

形形式显示嵌入式应用程序中的运行时变量和函数。

可以将数据以图形形式显示为以下变量：

• 原始数据流 8 位变量

• 采用数据流协议的多个变量

安装 MDV 插件时可以遵循 MCC 的安装步骤，二者惟一的区别就是插件的名称。该工具用于在实现应用程序后显示

ADC 结果。

https://microchipdeveloper.com/install:mcc
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2.4 任务：差分 ADC

2.4.1 初始化模块

本小节将提供开发一个简单的应用程序所需的全部步骤，其中包括将 ADC 配置为差分模式、通过 USART 发送结果，

以及使用图形界面分析数据。

MCC 将用于初始化所需的全部模块。要打开插件，请转到 Window → MPLAB Code Configurator → MPLAB Code
Configurator Open/Close（窗口 → MPLAB 代码配置器 → MPLAB 代码配置器打开/关闭），或者单击 MCC 图标，如

图 2-10 所示。

图 2-10. 打开/关闭 MCC

使用 MCC 开发该应用程序的第一步是提供初始化设置并将所需的外设模块添加到项目中。初始化系统时，用户必须为

所有必要的外设初始化所需的配置。之后，用户必须使用生成的源文件和头文件来实现将由 MCU 执行的算法。

2.4.1.1 配置器件系统

开发 ADC 应用程序的第一步是配置系统时钟。如需了解有哪些时钟选项，用户必须查阅器件数据手册中的 CLKCTRL
——时钟控制器一章。

例如，在本应用程序中，所选的主时钟频率为 2 MHz。

任务：使用 MCC 将内部高频振荡器配置为时钟源。振荡器的频率必须为 4 MHz。主时钟频率必须为 2
MHz。
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结果：打开 MCC，然后转到 Resource Management [MCC] → Project Resources → System → System
Module（资源管理 [MCC] → 项目资源 → 系统 → 系统模块）。在 Easy Setup（简单设置）选项卡中，必

须完成以下配置：

• 时钟控制

– Clock Source（时钟源）：内部振荡器

– Internal Oscillator Frequency（内部振荡器频率）：1-32 MHz 内部振荡器

– Oscillator Frequency Options（振荡器频率选项）：4 MHz 系统时钟（默认设置）

– Prescaler Enable（预分频器使能）：已选中

– 预分频比：2X

具体设置如图 2-11 所示。

图 2-11. MCC 时钟控制配置

2.4.1.2 配置 ADC
在本文档所述的应用程序中，ADC 将配置为差分模式。要使用 MCC 配置该模块的初始设置，用户必须先将该模块添

加到 Project Resources（项目资源）。

任务：在 MCC 中将 ADC 外设模块添加到 Project Resources。

结果：转到 Resource Management [MCC] → Device Resources → Peripherals → ADC（资源管理 [MCC]
→ 器件资源 → 外设 → ADC），然后单击绿色的+符号添加 ADC 外设模块。该模块随后将出现在 Project
Resources 窗口中。

下一步是配置 ADC 模块。ADC 将以差分模式运行，连续转换获取的采样（自由运行模式）。分辨率将是 12 位，预分

频值将是 4，差分输入将是 PD3（正输入）和 PD4（负输入）。
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任务：

• 使能 ADC 模块

• 使能差分模式转换，自由运行

• 将结果分辨率设置为 12 位

• 配置 ADC 预分频器以获得 500 kHz 的 ADC 频率

• 配置 ADC 输入引脚：ADC 输入引脚 3 作为负输入；ADC 输入引脚 4 作为正输入

结果：转到 Resource Management [MCC] → Project Resources → Peripherals（资源管理 [MCC] → 项目

资源 → 外设），然后选择 ADC0。在 Easy Setup 选项卡中，必须完成以下配置：

• Software Settings（软件设置）：

– Result Selection（结果选择）：12 位模式

– Differential Mode Conversion（差分模式转换）：enabled（已使能）

– Left Adjust Result（左对齐结果:）：未选中

• Hardware Settings（硬件设置）：

– Enable ADC（使能 ADC）：已选中

具体设置如图 2-12 和图 2-13 所示。

图 2-12. ADC0 软件设置

图 2-13. ADC0 硬件设置

此外，用户必须配置 ADC 寄存器。如需了解哪个寄存器中有哪些设置以及寄存器位和位域的可用配置，用户必须查阅

器件数据手册。

自由运行模式选项位于 ADC 模块的控制 A（CTRLA）寄存器中。通过写入 CTRLA 寄存器，用户可以使能/禁止在待机

模式下运行、选择转换模式、设置结果调整、选择分辨率，以及使能/禁止外设。该外设的时钟频率必须使用控制 C
（CTRLC）寄存器中的预分频器（PRESC）位域进行配置。

要使用 ADC 的差分模式，需要两个模拟输入。正输入必须使用 ADC 正输入的多路开关选择（MUXPOS）寄存器进行

配置，而负输入必须使用 ADC 负输入的多路开关选择（MUXNEG）寄存器进行配置。相应的引脚也必须配置为模拟

输入，并禁止数字缓冲器。
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可以在 MCC 的 Registers（寄存器）选项卡中配置寄存器。

• 寄存器：CTRLA
– FREERUN（自由运行）：enabled

图 2-14. ADC0 CTRLA 寄存器

• 寄存器：CTRLC
– PRESC：CLK_PER divided by 4（CLK_PER 4 分频）

图 2-15. ADC0 CTRLC 寄存器

• 寄存器：MUXNEG
– MUXNEG：ADC 输入引脚 4

• 寄存器：MUXPOS
– MUXPOS：ADC 输入引脚 3

图 2-16. ADC0 MUXNEG 和 MUXPOS 寄存器

2.4.1.3 配置 VREF
ADC 参考电压既可以通过写入 ADC0 参考电压（ADC0REF）寄存器进行设置，也可以使用 MCC 进行设置。
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任务：使用 MCC 将 VREF 模块添加到 Project Resources，并将 ADC 参考电压配置为 2.048V。

结果：转到 Resource Management [MCC] → Device Resources → Peripherals → VREF（资源管理

[MCC] → 器件资源 → 外设 → VREF），然后单击绿色的+符号添加 VREF 外设模块。该模块随后将出现在

Project Resources 窗口中。

转到 Resource Management [MCC] → Project Resources → Peripherals，然后选择 VREF。在 Easy
Setup（简单设置）选项卡中，必须完成以下配置：

• Hardware Settings
– ADC Voltage Reference（ADC 参考电压）：Internal 2.048V reference（内部 2.048V 参考电

压）

图 2-17. VREF ADC 参考电压

2.4.1.4 配置 USART
使用 ADC 对收到的模拟数据进行转换后，用户可进一步发送数据以进行分析。要将数据发送到开发计算机主机，将使

用 USART 外设模块。在 AVR128DA48 Curiosity Nano 板上，USART1 的 RX（接收）和 TX（发送）引脚直接连接到

调试器引脚，所以用户无需额外的电线即可向计算机发送数据。因此，本应用程序中使用的 USART 外设模块将是

USART1。

任务：使用 MCC 将 USART1 模块添加到项目中。

结果：转到 Resource Management [MCC] → Device Resources → Peripherals → USART（资源管理

[MCC] → 器件资源 → 外设 → USART），然后单击绿色的+符号添加 USART1 外设模块。该模块随后将出

现在 Project Resources 窗口中。

将该模块引入项目后，必须进行一些初始配置。

任务：对 USART1 进行以下配置：在异步模式下运行，波特率为 9600，无奇偶校验，1 个停止位。字符大

小必须为 8 位。

信息：无需使能 USART RX：器件不需要从计算机接收数据。只需要使能 USART TX。
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结果：转到 Resource Management [MCC] → Project Resources → Peripherals，然后选择 USART1。在

Easy Setup 选项卡中，必须完成以下配置：

• Hardware Settings
– 模式：Async Mode（异步模式）

– Baud Rate（波特率）：9600
– Enable USART Transmitter：已选中

– Parity Mode（奇偶校验模式）：无奇偶校验

– Stop Bit Mode（停止位模式）：1 个停止位

– Character Size（字符大小）：8 位

具体设置如图 2-18 所示。

图 2-18. USART1 硬件设置

2.4.1.5 配置引脚模块

在 Pin Manager: Grid View（引脚管理器：网格视图）窗口中，必须选择 ADC 的输入引脚。选择 PD3 和 PD4，如图

2-19 所示。必须按如下所示配置 USART 的接收引脚和发送引脚。

图 2-19. Pin Manager: Grid View（引脚管理器：网格视图）

若要用作 ADC 输入，必须将输入引脚配置为模拟输入（禁止数字缓冲器）。必须禁止弱上拉和中断。

任务：使用 MCC 进行以下设置：

• 禁止相应引脚上的数字输入缓冲器

• 禁止相应引脚上的弱上拉

• 禁止中断
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结果：转到 Resource Management [MCC] → Project Resources → Pin Module（资源管理 [MCC] → 项目

资源 → 引脚模块），然后按图 2-20 所示进行配置。

图 2-20. 引脚模块

2.4.2 生成代码概述

要使用 MCC 生成设计的代码，请单击 Generate（生成）按钮。之后，若要继续进行应用程序开发，应关闭 MCC。

MCC 生成的文件可以在 Projects 选项卡中已创建项目的下方查看。

图 2-21. MCC 生成的文件

生成的文件被包含在主源文件中，随后系统被初始化。下面给出了针对 main.c生成的代码。

例 2-1. 代码清单 1——生成的主文件

#include "mcc_generated_files/mcc.h"

/*
    Main application
*/
int main(void)
{
    /* Initializes MCU, drivers and middleware */

SYSTEM_Initialize();

    /* Replace with your application code */
while (1)
{
}

}
/**

End of File
*/
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SYSTEM_Initialize函数用于初始化系统和所有外设模块（与之前使用 MCC 配置的一样）：系统时钟、ADC、

USART 和 VREF。

信息：使用 ADC0、USART0 和 VREF 实现的算法所需的全部函数已由 MCC 生成完毕。

生成的文件中提供 ADC 和 USART 函数，以帮助用户实现算法。本应用程序所关注的函数为

ADC0_GetDiffConversion和 USART1_Write。它们在 MCC 生成的文件中的实现如以下代码清单所示。

例 2-2. 代码清单 2——用于获取差分转换结果的 ADC 函数

diff_adc_result_t ADC0_GetDiffConversion(adc_0_channel_t channel,
adc_0_muxneg_channel_t channel1)
{

diff_adc_result_t res;

ADC0_StartDiffConversion(channel, channel1);
while (!ADC0_IsConversionDone());
res = ADC0_GetConversionResult();
ADC0.INTFLAGS |= ADC_RESRDY_bm;
return res;

}

例 2-3. 代码清单 3——用于发送 ADC 结果的 USART 函数

void USART1_Write(const uint8_t data)
{

while (!(USART1.STATUS & USART_DREIF_bm)) ;
USART1.TXDATAL = data;

}

2.4.3 实现所需的算法

本小节将介绍如何在主文件中使用生成的文件实现算法。此外，还将提供使用数据可视化器测试应用程序所需的函

数。

MPLAB 数据可视化器在编程的嵌入式器件与计算机之间提供简单的单向通信。嵌入式应用程序必须控制何时发送数据

以及如何发送数据。在本例中，数据将按图 2-22 所示进行打包。

图 2-22. 数据可视化器 ADC 数据帧

1	Byte 1	Byte

Frame	Start	Token Frame	End	Token

ADC	12-bit	Result	-	Least
Significant	Byte

ADC	12-bit	Result	-	
Most	Significant	Byte

发送的数据必须通过开始令牌和结束令牌打包成帧。这两个令牌彼此之间互为二进制补码。数据可视化器负责同步成
帧令牌和有效负载大小。在多字节变量中，必须先发送低字节。

任务：为了读取 ADC 差分结果并将其发送给计算机，必须在主文件中实现以下代码。
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例 2-4. 代码清单 4——读取 ADC 结果并发送

int main(void)
{

diff_adc_result_t adcVal_12b;

    /* Initializes MCU, drivers and middleware */
SYSTEM_Initialize();

while (1)
{

adcVal_12b = ADC0_GetDiffConversion(ADC_MUXPOS_AIN3_gc,
ADC_MUXNEG_AIN4_gc);

USART1_Write(START_TOKEN);
USART1_Write(adcVal_12b & 0x00FF);
USART1_Write(adcVal_12b >> 8);
USART1_Write(END_TOKEN);

}
}

任务：START_TOKEN和 END_TOKEN是用户定义的宏，若要在主函数中使用，必须也在 main.c文件中定

义一次，具体如下所示。

#define START_TOKEN 0x03    /* 开始帧令牌 */
#define END_TOKEN 0xFC /* 结束帧令牌 */

View Code Example on GitHub
Click to browse repositories

2.4.4 应用程序测试：调试

测试应用程序功能的方法之一是分步执行它，然后检查所有实现的指令是否提供了预期的结果。

任务：在主函数中的 SYSTEM_Initialize();函数调用上使能断点。进入调试模式。

https://github.com/microchip-pic-avr-examples/avr128da48-cnano-adc-differential-mcc
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结果：通过单击文件行旁边的编辑器装订线可创建新的行断点。相应的行如下所示。

图 2-23. 使能断点

要查看寄存器的内容，请转到 Window → Debugging（窗口 → 调试），然后选择 IO View（IO 视图）。随后将打开

IO View 窗口。要开始调试，请转到 Debug（调试），然后选择 Debug Main Project（调试主项目）。程序将执行到

断点处停止。

单击 Step Over（单步跳过）按钮后，用户可以通过查看 IO View 窗口中的寄存器来检查 ADC 外设是否按要求进行了

初始化等。IO View 窗口中的寄存器如图 2-24 所示。

任务：检查是否所有的配置都按要求完成。



 AVR® DA 培训手册
模数转换器培训

© 2023 Microchip Technology Inc.
及其子公司

  培训手册 40002244A_CN-第 24 页

图 2-24. ADC IO View

通过单步执行应用程序，用户可以看到：

• ADC 结果（RES）寄存器中的转换结果

• 需要通过 USART 发送的数据——在 TXDATAL 寄存器中

• adcVal 变量的值，使用 Variables（变量）窗口

2.4.5 应用程序测试：数据可视化器

使用 MPLAB 数据可视化器可以轻松测试应用程序。要绘制通过 USART 发送的 ADC 结果，必须遵循以下步骤：

1. 单击插件图标打开数据可视化器插件，如图 2-25 所示。

图 2-25. 打开数据可视化器

2. 从 Connections（连接）选项卡中选择 Curiosity Nano communication port (COMn) drop-down list
（Curiosity Nano 通信端口（COMn）下拉列表），如图 2-26 所示。
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图 2-26. COMn 端口——显示下拉列表

3. 从下拉列表中选择 New variable streamer...（新建变量流...），如图 2-27 所示。

图 2-27. COMn 端口——从下拉列表中选择

4. 选择 Variable Streamer Name（变量流名称），添加将接收的变量，然后单击 Next。
图 2-28. Configure Variable Streamer（配置变量流）
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5. 根据需要选择要绘制的变量，然后选择 New axis per data type (1)（按照数据类型新建轴（1））作为绘制数

据的方式。最后，单击 Finish（完成）。

图 2-29. Choose Variables to Plot（选择要绘制的变量）

随机转到两个电位器就获得了绘图。ADC 结果如图 2-30 所示。

图 2-30. 数据可视化器 ADC 结果绘图
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3. 结论
完成本文档提供的培训后，用户可以了解 ADC 的基本特性，了解如何使用开发嵌入式应用所需的软件工具，以及使用

ADC 模块独立开发一个基本的应用程序。此外，用户还将了解如何配置 ADC 以转换来自差分输入的数据，如何连续

转换数据，以及如何解析结果。本培训还提供了调试应用程序和查看结果所需的步骤。
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4. 参考资料
1. 数据可视化器软件用户指南

2. MPLAB®代码配置器（MCC）

3. 如何在 MPLAB 代码配置器（MCC）中添加库

4. 下载 MCC 最新库的 Microchip 网页
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https://www.microchip.com/Developmenttools/ProductDetails/AC164162
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